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	Multi-Dimensional Reporting Overview


	Introduction

	Multi-Dimensional reports allow business data to be viewed dynamically from a variety of different business perspectives.

Unlike flat or paper-based reports, multi-dimensional reports allow the user to combine various aspects of the business together and manipulate them to discover business information.

Using the eTrack BI interface, complex and powerful analysis can be performed on large quantities of data quickly and with a minimum of training or technical expertise.

The result is an intuitive view of the business that is instantly understood by senior management.




	Multi-Dimensional Databases

	A multi-dimensional database is a database that stores data in a multi-dimensional structure containing a number of pre-defined aggregations.

These multi-dimensional structures are called data ‘cubes’ and eTrack BI is a tool to present the cube information to the user in a useful, powerful and easy to use way.




	Dimensions and Measures

	The two key principles of multi-dimensional reporting are Dimensions and Measures.

Dimensions

Dimensions are a way of looking at a business.  For example, a ‘Product’ Dimension can be used to analyse sales by product.

The power of multi-dimensional reporting comes from combining Dimensions to analyse the relationships between different aspects of the business.  For example, combining a ‘Product’ Dimension with a ‘Customer’ Dimension to analyse sales data.

Dimension Levels

Dimensions can have multiple levels to allow analysis at different aggregations of data.  For example, the Customer Dimension can be aggregated to ‘Customer Region’ for a more summarised view of Customer data.

Measures

Measures are the ‘measures’ of business performance – the numbers that are reported.

The Measures are aggregated depending on the combination of Dimensions selected in a multi-dimensional report.

A multi-dimensional report can contain several measures for each Dimension combination.  For example, the Dimension combination of ‘Product Group’ and ‘Customer Region’ could report the ‘Revenue’ and ‘Cost of Goods’ values for ‘Hardware’ in ‘Northern Region’.




	Views

	In eTrack BI a ‘view’ is a formatted presentation of data in a multi-dimensional database.

eTrack BI is a tool to configure and display views through an easy to use, intuitive and powerful interface.

eTrack BI can contain many views for many different multi-dimensional database cubes.  




	Drilling Up and Down

	Drilling up or down is the process of displaying a dimension’s data in more or less detail.

Drilling Down

Drilling down is moving from a summarised view of data to a more detailed view.

The levels defined in the Dimension determine the data aggregation at each level.  For example, the Customer Dimension could contain three levels of aggregation:

Customer Region

· Customer City

· Customer

In the example, ‘drilling down’ involves moving from Customer Region to Customer City to Customer

Drilling Up

Drilling up is the process of moving from a detailed view of data to a more summarised view.

In the example above, ‘drilling up’ involves moving from viewing the data at a Customer level, to a Customer City level to a Customer Region level.




	Time and Type

	Time and Type are both Dimensions, but they have properties that rate a special mention.

Time

The Time Dimension is required by eTrack BI to show the movement of Measures over time.  It can be customised to suit the business but generally tends to be made up of a standard:

· Year

· Quarter

· Period

· Day

eTrack BI contains a number of features that manipulate the Time Dimension to provide analysis such as:

· Year to Date

· Total Year

· Remaining Year

· Rolling Time Periods

Type

Type is also an important Dimension in eTrack BI.  It is used in combination with the Time dimension to provide combinations of types of business data over time.

Type is usually used to distinguish Actual, Budget and Forecast data but can be used for any business type requirement.




	Calculated Measures

	A feature of Multi-Dimensional reporting is the ability to calculate Measures dynamically.  Calculated Measures apply calculations to the original Measures from the source data and display the results as new Measures.

Calculated Measure can be created both within OLAP Cubes and within eTrack BI.

An example of a Calculated Measure is ‘Gross Profit’ which could be made up of the following calculation:

‘Sales Revenue – Sales Cost’




	Interface Overview


	Launching eTrack BI

	eTrack BI can be launched from within eTrack or from the desktop.  

To open a pre-defined view, select the view module and name from the drop-down menus and click on the ‘Open View’ button.




	Menu Items Explained

	From left to right across the Menu bar at the top of the screen:
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File

The file menu is used to:

· Add new views

· Open existing views

· Open all views in a group of views (if allowed in ‘Preferences’

· Delete views

· Re-open (refresh) views

· Save a view with a new name (Save As)

· Print a view

· Send a view to an email recipient

· Exit the program

Edit

The Edit menu contains:

· Cut

· Copy

· Paste

· Preferences (settings for maximizing opening windows, allowing multiple windows to be open and colour options for the screen)

View

The View menu is used to:

· Hide/show a menu bar of standard Windows functions

· Hide/show the Status bar at the bottom of the screen

· Hide/show one or two bands of Filters (this option is only available when a View is open)

Format

The Format, Font menu allows the font used in the currently selected view to be changed.




	Menu Items Explained (continued)
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Tools

The Tools menu is used to:

· Export to/Import From XML – Views can be copied to and from eTrack BI.

· Open the ‘Maintain Views Database’ function to maintain the database that contains the View configuration details.

· Print the current screen

· Create an Excel Pivot table report - launches MS Excel Pivot Table Services and connects to the cube used in the current view

· Export View to an Excel workbook - launches MS Excel and places each Quadrant into a separate worksheet

Window

The Window menu has the standard Windows functions for cascade, Tile Horizontal/Vertical plus:

· Reset – to set a View to default settings

· Setup – to open the View configuration screen

Help

On-line Help files are not currently active but:

· ‘Help on Q4bis.com’ item gives access to Help files on the Web.

· Help About provides the version number and registration details.




	Quadrants

	Each eTrack BI view contains one or more Quadrants containing either a table or a chart.  A eTrack BI View will often contain 4 Quadrants – hence the name Quadrant (four) and Q4.

In a four quadrant screen, viewing from left to right, top to bottom, the quadrants are called Q1, Q2, Q3, and Q4
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In the example above Q1 and Q3 contain tables, Q2 contains a chart and Q4 contains a list of measures.

A Quadrant will usually contain a Dimension but can also contain:

· A chart

· A list of all Measures (a table)

· A list of all periods in a year (from the Time Dimension)

Charts can be placed in Q2 or Q3 and always chart the data in the data table beside them.  A chart in Q2 uses the data in Q1 as the source and a chart in Q3 uses the data in Q4.




	Views

	A View is the combination of configuration settings that creates a presentation of data in a cube.  A view contains settings that specify:

· Connection details to the data source

· The Dimensions to show in each quadrant

· The Measures to display for each Dimension

· The default time period to display

· The format and sorting of Measures

and other settings that will be covered in the Configuration module.

View Group

Views can be grouped into Modules or ‘Groups’.  A group of Views normally contains Views for one aspect of a business, for example, a Sales group or an Expenses group.
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In the example above the View group is ‘Sales’

Select the View Group using the first drop-down menu item at the top of the A4BIS Analysis screen.

View Names

Views are distinguished by their names.  The second drop-down menu list at the top of the A4BIS Analysis screen lists the Views available in the Group.
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In the example above the View name is ‘Sales Analysis’
To open all Views in a Group, select File, ‘Open All Views in Group’.




	Time Periods

	The currently selected time period is displayed at the top if the screen.  eTrack BI can be set to either:

· Open a View at a pre-defined time period

· Open a View in the latest time period to contain data

Once a View is open the time period can be adjusted as required.

[image: image7.png]|| [Currently selectedperiod =] 4 [[oecember =] ) [2002 =] EE|




Time periods displayed by Q4 Analysis are determined by the source data but are generally made up some or all of:

· Day

· Week

· Month/Period

· Quarter

· Year

Time periods will be covered in more detail later in this module.




	Status Bar

	The Status Bar lists:

· The source data cube for the current View

· The date and time that the cube was last updated
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The Status Bar can be set to display or not display using the ‘Status Bar’ option in the View menu.




	Menu Bar

	The Menu Bar at the top of the screen has three main functions:

· Select Modules and Views

· Open View or open View configuration screen

· Select time periods
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Select Module and View

Views can be grouped into modules – for example, all views based on a Sales cube can be grouped under a ‘Sales’ module.

To select a module, use the left-hand drop-down list:

Open View

To open a pre-defined View, click on the ‘Open View’ button

Configure View

To open the View configuration screen, click on the ‘Setup View’ button.

Select a Time Period

There are four components that manipulate the time periods which will be covered in more detail later.  The components are:

· Special Time Period - current period/YTD/Total Year/Remaining Year/Rolling Year/Rolling 12 months

· Period – period/month/quarter/week/day

· Year

· Time Level – year/quarter/month/week/day




	Context Menus

	Right-clicking in a eTrack BI View will open a context menu with further options for analysing the data.

Right-Click on Descriptions

Right-Clicking anywhere in the description or description heading area of a quadrant will prompt a context menu containing options such as:

· Select alternative Dimension

· Select Dimension Level

· Display Dimension item keys or both keys and descriptions

· Show all Measures in the quadrant

· Show all time periods in the quadrant

· Change the grid size

· Display a chart in the quadrant (Q2 and Q3 only)

· Change the font

· Open the View configuration screen
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The example above shows the context menu displayed after right-clicking on a dimension description.




	Context Menus (continued)

	Right-Click on Measures

Right-Clicking on the Measures or Measure heading areas will prompt a context menu containing additional options such as:

· Select an alternative Measure

· Select an alternative Time and Type combination
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The example above shows the context menu displayed after right-clicking on a Measure.  Note the Dimension items are deselected.



	Driving the Views – 2 Minute Training


	Introduction

	Some of the most powerful functionality of eTrack BI is available with an absolute minimum of training.  It is possible to negotiate a view by selecting items and drilling down and up for more or less detail with four actions:

· Drill Down

· Drill Up

· Select and Remove selection

· Drill down on all items




	Drill Down (plus sign) 

	To drill down into items to show more detail simply click on the numbers (the Measures) for the item you wish to drill down on.

The cursor will change to a plus symbol where it is possible to drill down. [image: image12.png]
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In the example above eTrack BI will drill down to display the items below ‘Garden Appliances’




	Drill Up (minus sign) 

	To drill up in a Dimension simply click on the Measure area of the header bar in the Dimension.

The cursor will change to a minus symbol where it is possible to drill up. [image: image14.png]



[image: image15.png]Product roup Level
ElecuicalsbQ Siessis| 4371208
Other Garden Appliances 23367 2023





In the example above eTrack BI will drill up to the level above ‘Product Group’




	Select (hand symbol) 

	To select an item in one quadrant and filter the corresponding data in the other quadrants simply select the name of the item.

The cursor will change to a hand symbol where it is possible to select an item. [image: image16.png]



[image: image17.png]



In the example above the item ‘Garden Appliances’ has been selected.  Note that the other quadrants have changed to reflect the selection.




	Remove Selection 

	To remove a selection (and select all items) select the name of the quadrant total.

The cursor will change to a hand symbol where it is possible to select all items. [image: image18.png]
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In the example above the name ‘All Product Family’ is clicked to select all items in the Dimension.




	Drill Down on all items 

	To display all items at the next lower level simply click on the Measure totals in the quadrant.

The cursor will change to a plus symbol where it is possible to drill down. [image: image20.png]
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In the example above the total for ‘Product Family’ has been clicked to show all items at the level below.




	Sort Items  

	To sort quadrant items or Measures click on the column header.  The sort toggles between ascending and descending.

If a column has been sorted a small triangle will display in the column header showing the direction of the sort. [image: image22.png]
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In the example above the quadrant has been sorted by 2002 Revenue, descending.




	Driving the Views – Extended Features


	Introduction

	The power of Q4 Analysis is extended with sophisticated functions to analyse data by special time periods, display alternative Dimensions and Measures, change the format of the screen and export views to other analysis tools.

This section covers the functions a user can perform that extend the analysis possibilities of eTrack BI.




	Special Time Periods

	Special Time Periods are tools to group time in ways that are meaningful to a business.

From any view it is possible to change the Time period to the following special time periods:

· Currently selected period

· Total Year

· Year to Date

· Remaining Year

· Rolling 12 Months
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Note that other time period functions are available from the View configuration screen and are covered in the configuration module.

Currently Selected Period

The time period set as a default in the original configuration of the view.

Often the currently selected period will be the most recent period that contains data.




	Special Time Periods (continued)

	Total Year

Selecting Total Year will select the full time range of the year displayed.
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Year to Date

Year to Date aggregates all Measures up to the period displayed for the year displayed.
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Remaining Year

Remaining Year aggregates all Measures from the period displayed to the end of the year displayed.
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Rolling 12 Months

Rolling 12 months aggregates all Measures from the period displayed back 12 months.
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	Time Level

	When a View is configured it can be set to default to one of the time levels that has been defined in the time dimension of the source cube.  For example, 

· Year

· Quarter

· Month

· Day

To change the Time Level, click on the Calendar icon and select the required level.

The selection will appear in the Time Period field.
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	Resetting or Reopening Views

	There are two ways to quickly return to a starting point after drilling and selecting and swapping.

Note that any changes made to a View will not be saved when the view is closed.  A View will always return to the default configuration when opened.

Return to Top levels 

Clicking on the ‘Reset View’ button returns all displayed Dimensions to the highest levels.  All other changes, for example, time period, Dimensions and Measures displayed, etc. are retained. [image: image31.png]



Reopen View

The Reopen View function from the File menu closes the current View and re-opens it with all default settings. Use Reopen View to fully reset a View after drilling, selecting and swapping.
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	Filter Dimensions

	Filter Dimensions can be used as extra dimensions to restrict the information returned by the report.  A filter dimension does not return any information itself.

Note that Filter Dimensions are not saved when a View is closed so they do not reappear when the View is reopened.  If required, a Q4bis Administrator can save Filters and make them available to all users.

Adding a Filter Band

Filter Dimensions are added to a View from the Filter Band.  To add a Filter Band, select ‘Filter Band 1’ from the View menu.  It is possible to have two Filter Bands in any View.
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Adding a Filter Dimension

Each Filter Band is made up of five buttons that can be used as filter dimensions.  To add a Filter Dimension, click on one of the Filter Band buttons.

Select the Dimension to be used as a Filter Dimension by ticking the appropriate check box.
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Select the level of the Dimension to filter into the report.

For example, in the filter pictured below, to include only Customers of Type ‘Department Stores’ in the report, click on ‘Department Stores’.
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Filter ‘Always on Top’

The Dimension Filter window can remain open and be used to dynamically filter the report.

Selecting level nodes in the Dimension Filter tree will filter the report to include only the level node selected.

Closing the Filter Dimension Window
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 To close the Filter Dimension window and remove the filter setting, click the discard (cross) icon. 
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 To confirm the existing filter selection click on the green tick icon. 




	Swapping Dimensions

	A View is set up to display the default Dimensions each time it is opened but there may be more Dimensions available.

To change the Dimension displayed in a quadrant, right-click anywhere in the quadrant item description column.

A context menu will display.  Hover the cursor over the ‘Dimension’ item and a list of the available Dimensions will display.

Selecting a Dimension will replace the Dimension in the quadrant with the alternative Dimension selected.
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In the example above the Product Family Dimension is to be replaced in quadrant 1 with the Customer Type Dimension.




	Showing Time in a Quadrant

	To display a quadrant containing all the periods for the currently displayed year:

· Right-click anywhere in the quadrant item description column

· Select Dimension

· Select Time (Period)
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	Display Item Codes

	eTrack BI displays item descriptions by default.  To display item codes or both item codes and descriptions:

· Right-click anywhere in the quadrant item description column

· Click on Display

· Click on either Default, Code or Both
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In the example above both the item Descriptions and Codes are displayed.




	Changing the Grid Size

	The size of a quadrant can be changed to make it easier to display large amounts of data.

Expand Horizontally

Increasing the size of a quadrant horizontally spreads the quadrant over the quadrant beside it.

Expand Vertically

Increasing the size of a quadrant vertically spreads the quadrant over the quadrant on top of or below it.

To Change the Grid Size of a quadrant:

· Right-click anywhere in the quadrant

· Hover the cursor over Grid Size

· Click on Normal, Expand Horizontal, Expand Vertical or Expand Full
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	Displaying Charts

	Charts can be displayed in Quadrant 2 and Quadrant 3.

To display a chart in a quadrant:

· Right-click anywhere in quadrant 2 or 3

· Hover the cursor over Trend Chart or Bar Chart

· Chose the quadrant for the chart
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	Swapping Measures

	A View is set up to display a set of default Measures each time it is opened but there may be additional Measures available.

To change the Measures displayed in a quadrant, right-click anywhere in the quadrant Measure columns.

A context menu will display.  Hover the cursor over the ‘Measure’ item and a list of the available Measures will display.

Selecting a Measure will replace the measure in the column selected with the alternative Measure selected.
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In the example above the Revenue Measure is being replaced with the Volume Measure




	Changing the Type and Selected Period

	A View is set up to display Measures for the default Time period and Type each time it is opened but these can be changed in a session.

To change the Time or Type range for a Measure column:

· Right-Click on the Measure column

· Hover the cursor over ‘Type’

· Make a selection from the list of Times and Types
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In the example above the Actual Current Year Measure column is being replaced with Budget Current Year.




	eTrack BI and Excel


	Create Excel Pivot Table

	The data connection properties that connect a eTrack BI View to a cube or local cube can also be used to create a pivot table in Excel 2000.

To create a pivot table in Excel from a eTrack BI View:

· Open a View

· Select Tools

· Select Create Excel Pivot Table

You can then use the Excel pivot table wizard to create a pivot table from the existing connection.

Note that it isn’t possible to exactly replicate a eTrack BI View in an Excel pivot table because eTrack BI uses a number of features that are not available to Pivot Table Services.




	Export to Excel Workbook

	Each table quadrant in a eTrack BI View can be exported to an Excel sheet for further analysis or formatting.

The data exported to Excel will be exactly what is reported at the time of Export, for example, if a View is displaying Quadrant 1 data at Level 2, then Quadrant 1, Level 2 will be exported to Excel.

To export a View to Excel:

· Open a View

· Select Tools

· Select Export to Excel Workbook

Note that Charts cannot be exported to Excel.




	Drillthrough


	Drill Through to Source Data

	Drillthrough is the ability to drill from the lowest level of a Dimension in a Cube to the underlying source data.  It is a setting that can be configured in Analysis Services cubes.

Drilling through to the source data allows the user to see more data than would otherwise be shown in a View.

If Drillthrough is configured in the source cube then eTrack BI will display the Drillthrough icon at the bottom level of a Dimension, indicating that drilling further will drill through to the underlying data.




	Printing


	Overview of Printing in Q4bis

	Printed reports can be created from any eTrack BI View.  The print function will create a report on paper of anything that shows on the screen 

Reports can print the results that display when a View is first opened and they can also display the results from manipulating the data by slicing sorting and selecting.

The print function in eTrack BI is actually a powerful report writer that uses the intuitive eTrack BI interface as the selection criteria for a printed report.




	Print all Quadrants

	To create a printed report of a eTrack BI View, first manipulate the data in the View by selecting the required Dimensions and Measures, and slicing, sorting and drilling as required.

The resulting report will reflect the selections made in the View.

Print Preview

The Print Preview function displays the report on screen.  It also has a Print Setup button where printer settings can be changed.

Printing the Current View

To open the Print screen select File, Print.

To accept the default settings and create a report from the current view, select the ‘Print’ button.

A Printer Settings dialog box will appear.  To accept the default settings select ‘OK’ or change the settings as required.




	Print all Quadrants (Continued)
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In the example above the default settings will print all 4 quadrants of the View with page breaks between each quadrant.




	Selecting Quadrants to Print

	Since each quadrant in a Q4bis View is a report in itself, the print function allows each quadrant to be printed individually.

To select the Quadrants to print check the tick boxes for the required Dimensions in the ‘Available Dimensions’ pane.

To limit the number of items that prints for each Dimension, enter the From and To values of the range.  The numbers represent the order of the items, for example to print the top 100 items in a Dimension enter 1 into the From field and 100 in the To field.




End eTrack BI Help
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